Treasure Coast

acintsh
®

Users Group

1819 SW Willowbend Lane •
Palm City FL 34990 • (772) 283-5646

MEETING
Thursday June 19
LOCATION - Children’s Services Council
• 211 SE Central Parkway, Stuart 34994 •
In the Green building between Unity Church
and Bridges Montessori. Click on this map
link - http://tinyurl.com/clq2mkk

EXTENDED HELP SESSION

5 - 6:45 P.M. “Here To Help”
Bring your laptop, iPad or iPhone and enjoy
a format with Beginners tables throughout the
room, where you can just join any group:
• iPad			
• Basic Help
• iPhone		
• Email & Internet		
• iPhoto		
• How can I ...
7:00 P.M. “Pages”
Carol will show you
how Pages for Mac is a
powerful word processor that gives you
everything you need to
create documents that
look beautiful - and read
beautifully. It lets you work seamlessly
between Mac and iOS devices. It even
works effortlessly with people who use
Microsoft Word.
See you there!

Mouse Tales
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• Early Front Page Edition •
http://www.tcmug.net
MISSION: Since 1988, TCMUG has provided
a forum for Apple users by creating a member
network to share information and offer support
in the evolving world of technology.

iOS 7 iPhone or iPad: Control Centre

Swipe up from the bottom of the screen from anywhere in iOS and you get the phone's quick settings
panel. There are five buttons that allow you to put
your device in airplane mode, disable Wi-Fi, disable
Bluetooth, turn on/off Do Not Disturb and adjust portrait lock.
Brightness settings can be toggled with a slider, followed by the ability to control your music by skipping
songs, pressing play/pause and adjusting the volume.
AirDrop and AirPlay are found underneath.
Apple has also added a torch (flashlight) and next
to that is the quick button to the alarm clock, calendar
and camera buttons.
If you've got a pesky app that isn't working too well
because the Control Centre keeps coming up instead,
you can disable it in apps and on the lock screen. Go
to Settings > Control Centre > and select what you
want from there.

IN THIS ISSUE -

• iOS7 Tip - Control Centre
• Stop Your iPhone from Remembering
Everywhere You Go
• Mac Basics: Preview
• IT pros recommend Macs to friends
• iOS 7: Block incoming phone calls,
iMessages & FaceTime requests
• Have a Very iMessage Holiday

How to Stop Your iPhone from Remembering Everywhere You Go - All the Time

~ Alyssa Bereznak
￼
You probably know that a lot of iPhone apps log
your locations so they can offer directions or geographic-based recommendations. But did you know
the iPhone keeps a separate, locally stored history of
everywhere you’ve been?
It’s called Frequent Locations, and as BuzzFeed
recently found out, this cache of location info “contains a perfect record of where you’ve been in the last
month or so. That includes the exact time you arrived
at and left anywhere: your office, a bar, that person’s
house.”
Yes, if you were somewhere you shouldn’t have
been, it’s probably not helpful to keep a record of
that. This feature has existed on iOS 7 since it was
launched in September of 2013 last year. It doesn’t
store everything, but if your iPhone were to fall into
the hands of someone who knows about this feature,
it could be disastrous.
Here’s how to view that history. And, more importantly, how to shut it off:
1. Go to Settings.
￼
2. Select Privacy.
￼
3. Select Location
Services.
￼
4. Scroll all the way
down to the bottom of the
screen, and select System
Services. >>>>>>>
￼
5. Select Frequent
Locations.
￼

6. To see where you’ve been, tap the bar under
History at the bottom of the screen. This could be
helpful for remembering where that wonderful café
you stumbled upon is located. Or reminding you which
street your new doctor’s office is on.
￼
7. Your History
takes into account
your Home and Work
locations (filtered in
from Apple or Google
Maps), and logs the
number of times you
visited, and the duration you stayed there.
Tap a location to see
all the specific times
you’ve visited. >>>
￼
8. These entries are
not always entirely
accurate. For instance,
I have my settings
adjusted so that location services kicks in only when
I’m hooked up to WiFi
(to save battery life). So,
for me, the duration of a
recorded visit depends on
if and when I remembered
to enable WiFi. <<<<<
￼
Once you’re done looking at all that noise, go
back to the Frequent Locations page. If you want
to delete any trace of your
whereabouts, tap Clear
History at the bottom of
the page.
￼
9. Then turn Frequent
Locations off.
￼
Now you can travel around your town without worrying that your phone is recording your every move. The
NSA, on the other hand, I can’t speak for.
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Mac Basics: Preview
app views and edits
PDFs and images
~ apple.com

Preview makes it easy
to read Portable Document Files (PDFs) and
open popular image files including
JPEG, TIFF, and PNG.
Learn about Preview's essential
editing capabilities, such as resizing, rotation, cropping, and annotating PDFs and images in OS X.
￼
Viewing and working
with PDF files
To view a PDF file, double-click
it to open it in Preview, or drag the
PDF file's icon to the Preview icon
in your Dock. Preview lets you do
more than just view PDFs. You can
zoom in or out, bookmark pages,
add notes or highlighting, copy
text, fill out forms, and more.
Using Preview in full screen
You can use Preview in full
screen, which takes full advantage
of your screen and optimizes your
experience while reading or viewing documents or images. To use
full screen, click the full screen
button ￼
in the top-right
corner of an open document window. You can then use gestures to
zoom, rotate, and flip through your
pages or images.
To exit full screen, move your
pointer to top of the screen. The
Preview menu bar should appear.
Click the full screen button
to exit full screen mode.
Using Smart Magnify
When using Smart Magnify on
a PDF document, Smart Magnify
automatically adjusts its width to

give you the best view
of the text or image
your viewing in the
PDF.
To use Smart Magnify, open a PDF or image
in Preview, then press
the tilde key (just below
the esc key on your keyboard). This opens a magnifying
window that you can move around
to focus in on a portion of your
document or image. To close the
magnifier window, press the tilde
key again.
Creating a signature
You can use Preview to take a
picture of your handwritten signature, and add it to PDF documents
that require your signature.
1. Choose Preview > Preferences, click Signatures, and then click
Create Signature.
2. Follow the instructions displayed on screen. Make sure your
signature fills the box on the left,
and sits on the blue baseline.
3. When your signature preview
looks correct, click Accept.
Signing a PDF
1. If you don't see the Edit toolbar, click the Edit button
in the toolbar.
2. Click the Signature
button.
If you have created multiple
signatures, click the Signature button a second time, and verify that
there is a checkmark next to the
signature you want to use.
3. Click the location where you
want the signature to appear in
the PDF. If you click a line, Preview shrinks your signature to fit
the line if needed.
4. To add an additional signature to the document, click a
line, or click once in the docu-

ment then click the location where
you want the signature to appear
(in OS X Mountain Lion, move
the mouse cursor between the two
clicks).
Viewing and working with
images
Use Preview to look at images, edit them, convert them to a
different format, or start a photo
slideshow.
Many images (such as JPEG,
TIFF, GIF, PNG) open in Preview
automatically from the Finder. To
open an image:
q Double-click the image file.
q Drag the image file to the Preview icon in the Dock.
q Drag a folder of images to the
Preview icon to open all of them at
once.
Tip: If an image opens in a
different application but you want
it to always open in Preview when
you double-click it, do this one
time: Control-click the file, let
go of the Control key, press the
Option key, then choose Always
Open With > Preview. Or, select
the image file, choose Get Info
from the File menu, then change
the "Opens with:" pop-up menu
choice to Preview.
When multiple image files are
open or a PDF document is open,
you can select the individual images or pages via the Sidebar. (see
 ￼ >>>>> continued
below)
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Customizing the Preview
toolbar
With an image or PDF open in
Preview, choose View > Customize
Toolbar. A sheet of favorite items
appears, including Crop, Rotate,
Print, Slideshow, and more. >>>>
q Add items to the toolbar by
dragging them from the sheet to
the toolbar.
q To remove items from the
toolbar, drag the item off the
toolbar.
q Rearrange items on the toolbar
by dragging them left or right.
q To change how items on the
toolbar appear (as icon, as text, or
as both), use the "Show" pop-up
menu at the bottom of the sheet.
Tip: To learn more about
Preview, choose Preview Help
from the Help menu in Preview.

Scanning
You can also scan documents from your scanner with Preview.
http://support.apple.com/kb/HT4505
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Trend: To avoid giving
free tech support, IT pros
recommend Macs to
friends and family
By Conner Forrest
Being known as the "techie"
of your family is nice little boost
to your ego in the beginning, but
it can quickly become the most
frustrating aspect of your existence. Recommending a computer
to a friend or family isn't the hard
part, it's the hand-holding and
support that comes with it. To get
around this, many IT pros, who
are resilient in their pledge to support Windows or Linux products,
have begun recommending Apple
computers.
When it comes to personal
computers, Microsoft and Apple
are still the warring factions of the
IT world, but stepping over the
proverbial line in the sand doesn't
hold the connotations that it used
to. By recommending Apple
products, IT pros are able to avoid
some of the most common troubleshooting issues and pawn off
some of the work.
The products
One of the main groans we hear
from our readers is the lack of customization with Apple products,
and it's true. Apple owners are
subject to the pre-set packages that
the company deems appropriate
while Windows and Linux users
have a myriad of options when
buying or building a machine. But,
most average users aren't looking
for that level of customizability.
Andrew Soderberg, vice president of customer support at OmniUpdate, Inc. and a long-standing
Mac proponent, said that ceding
that control is a blessing, not a
curse.

While you will probably end up
troubleshooting a Mac or two that
you have recommended, the good
news is that you don't have to if
that person lives close to an Apple
store — pawn them off on the
"Geniuses."

"I used to 'love' getting in and
customizing and tweaking computer settings for myself and
others. Now, as much as I like
the idea of 'total control', I don't
have the time or the inclination
to do that; and with a Mac, you
don't have to. I believe that Apple has found a pretty good balance between flexibility for the
user (via safe well designed user
interfaces) and 'lock down' where
users shouldn't or can't mess with
settings they don't know how they
affect the use of the computer,"
Soderberg said.
For most family tech support
providers, malware cleanup
and software/OS installs are the
majority of what they end up
dealing with. While Apple products are not impervious to malware attacks, they are easier to
keep clean. If you have to end up
troubleshooting a Mac, running a
McAfee scan probably won't turn
up much. Abdul Jaludi, CEO at
TAG-MC, recalls the calls he used
to received from friends and family with Windows products.
A lot of what finally pushes IT
pros over the line to recommend
Apple products is the "set it and
forget it" mentality of their products.

Outsourcing
For those of you that can't stand
to field another call about why an
iPhone won't sync or why there is
a spinning beachball of death, the
Apple Store can help bail them
out.
"If I do decide to help a friend or
family [with a Mac], I can figure
it out. If I am to busy or the client
doesn't have a budget, Apple does
offer great support in-store and
with the purchase of Applecare,"
said Adam Silver, creative director
at Silver Lining Productions.
Busy tech professionals have
to consider how much their time
is worth, and do they want to
be spending their evenings and
weekends doing what they do in
their day job. Many of them have
decided that they don't, and that it
is easier to recommend people to
get Macs and use the Apple Store
for support.
"When the hard drive on my
wife's Mac started making noise
we took it to the Apple Store.
They backed up her data, replaced
the failing hard drive, reinstalled
the operating system then restored
her data," Jaludi said. "It only
took them a day and even though
the warranty had been expired for
several years, they only charged
her for the hard drive and not for
the labor to replace it, reinstall the
Mac OS or to move her data. If
this had been a Windows PC, even
if it was under warranty, I would
had to spend an entire day or more
doing the same thing."
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iOS 7: Block incoming phone calls,
iMessages & FaceTime requests [Updated]
by David Chartier

In iOS 7, you can (finally!) block phone calls,
messages, and FaceTime requests. In the Settings
app you can go to Phone > Blocked or Messages >
Blocked to add phone numbers and email addresses.
A catch as of iOS 7.0.2, however, is that phone
number(s) or email(s) you want to block must already be added to a contact in your device; tapping
the Add New button displays a searchable list of
all your contacts, and there is no way right now to
manually add addresses. I should also note that this
is for blocking incoming phone calls, iMessages,
and FaceTime requests from phone numbers and
email addresses (iMessage allows you to register
both for these features); as far as I know, it doesn’t
work to block incoming SMS or actual emails.
Update: Thanks to Brian Webster on ADN, you
can block numbers and addresses without having to

add them to a contact. Just go to the Recent list in the
Phone or FaceTime apps, or tap ‘Contact’ at the top
of a conversation in Messages, then tap the (i) button
and scroll to the bottom of the details for that number
or address to find the ‘Block this Caller’ option.
On the upside, tapping a contact will add all of
their phone numbers and email addresses at once, so
there’s a trick you can use to save some time when
it comes to random addresses not yet assigned to a
contact:
• create a new contact, name it something like
“Undesirable”
• add all unwanted numbers and emails to this new
contact
• whenever you make significant updates to your
new contact, re-add them to the Blocked list (no, it
doesn’t update automatically).
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Have a Very
iMessage Holiday
by Nick Disabato

“I’m bored and lonely, say
something funny”
At 12:21 PM on December 24, I
sent this sentence via iMessage. It
caused absolute mayhem for three
weeks. Here is why:
• You cannot add or subtract
people from a group iMessage.
As a result, it’s impossible to unsubscribe from a group iMessage
unless all participants agree to stop
messaging it. Not wanting to be
on an iMessage is not an option.
The only way to stop the flood of
iMessages is to either disable group
iMessages, to block all senders
one by one, or to disable iMessage
entirely. All of these are “nuclear
options” that would probably mess
with your social life in very unpleasant ways.
• The recipient list of a group
iMessage is exposed to all participants. As a result, anybody can
copy the recipient list, add (or subtract!) a few people, and start an
entirely new thread. (Keep in mind,

however, that this
still preserves the old
thread.)
• iMessage is buggy
as hell. On a thread of
this size, random iMessages will spawn new
threads for no reason.
Recipients will not
receive iMessages for several days,
then receive over 4,000 at once. Or
they’ll just start receiving messages
from an existing thread in medias
res and have to begin making sense
of it.
• iMessage applies to your data
plan. This is great for cutting down
the number of texts you receive, but
if you have only a 2GB data plan
and aren’t on wifi over Christmas,
you will absolutely receive enough
insane GIFs to exceed your data
plan for the month… in, like, ten
minutes.
• Once the iMessage is sent, it’s
out of the sender’s hands. I can do
nothing to “fix” this: it has to come
from the group. The whole group. If
somebody wants to troll that group,
they are allowed to do so.
• iMessages are forever. Want

to revive a thread after
a really long time?
Go right ahead. Three
months after this thread
finally, mercifully
died down, somebody
sent “Hi everybody!
How’s it going?” to
the entire thread of
people, prompting desperate “UNSUBSCRIBE” texts and numerous
confused replies.
Now here’s why all the mayhem:
that first iMessage was sent to 108
people. I had to take two people out
to apology brunches because I blew
their data plans. Numerous people
missed really important texts from
loved ones. Nobody – myself included – could figure out what was
going on at any point.
Now, several people have begun
new friendships on the iMessage.
iMessage’s bugginess, permanence, and harrowing persistence
have built a small community of
friends. And building friendships is
the hardest and yet most important
thing. Best bet - iMessage to one
person at a time.

2014 MEMBERSHIP

Joining the Treasure Coast Macintosh Users Group will keep you from missing out on the best Mac
resource since the mouse — including the Monthly Meetings • Newsletter • Special Interest Groups
and more! Membership is just $30 a year per family - getting your colorful newsletter by e-mail.

q $30 Yearly Dues

Check payable to: TCMUG
(or Treasure Coast Macintosh Users Group)
Mail to:
1819 SW Willowbend Lane • Palm City FL 34990

Name _____________________________________________
Address _______________________________ Apt. _______
City ____________________ State _______ Zip _________
Phone _______________________ Fax ________________
Email address _______________________________________
Birthday (ex. Sep.24) His ________ Hers _______ Retired? ____
__ Beginner __ Intermediate __ Advanced __ Consultant
Computer model(s) _________________________________
Most used programs ________________________________
__ iPhoto __ Keynote __ Pages __ Numbers __ iWeb
__ Photoshop __ Quicken __ Skype
__ Filemaker __ InDesign __ MS Office

Check what items you use:
__ Scanner
__ iPhone
__ Pages (layouts)
__ iPad
__ Keynote (slides)
__ iPod
__ Numbers (data)
__ iMovie
__ Laptop
__ iChat
__ 2+ computers
__ iDVD
__ iTunes
__ iWeb
__ Digital Camera
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Officers

Helpline

President & Newsletter • Chris Kilbride
283-5646
chris@tcmug.net
Vice President & Publicity • Mark Weinberg
465-4890
mark@tcmug.net
Secretary • Kathy Finnerty		
220-8691
kathy@tcmug.net
Beginners SIG • Carol Vertesch
carol@tcmug.net
283-0843
Hospitality • Anita Farrell (after 12pm)
370-7167
anita@tcmug.net
• Moe Goldy
340-0652
moe@tcmug.net
• Guy Reer guy@tcmug.net
Photos & Graphics • Richard Lewis
287-4948
dick@tcmug.net
Technical Advisor (Apple) • Bob Jorritsma
398-0748
bob@tcmug.net
Video Production • Bill Farrell (after 12pm)
370-6407
bill@tcmug.net
(MagicJack)
924-1084
Member At Large • Tom Stout
288-3737
tom@tcmug.net
Palm Beach Liaison • Dave Sochrin
		
dave@tcmug.net

Comcast
• Bill Farrell - after 12PM
370-6407
bill@tcmug.net
DropBox
• Bill Farrell - after 12PM
370-6407
bill@tcmug.net
FileMaker
• Chris Kilbride
283-5646
chris@tcmug.net
iDVD
• Bob Jorritsma
398-0748
bob@tcmug.net
iMovie		
• Bill Farrell - after 12PM
370-6407
bill@tcmug.net
InDesign
• Chris Kilbride
283-5646
chris@tcmug.net
Internet
• Bob Jorritsma
398-0748
bob@tcmug.net
MagicJack
• Bill Farrell - after 12PM
370-6407
bill@tcmug.net
924-1084
(MagicJack)
OS X
• Bob Jorritsma
398-0748
bob@tcmug.net
Photos & Graphics • Dick Lewis
287-4948
dick@tcmug.net
Websites
• Bob Jorritsma
398-0748
bob@tcmug.net
		• Tom Stout
288-3737
tom@tcmug.net

2014
CALENDAR
Jan. 16 • Feb. 20
March 20 • April 17
May 15 • June 19
July 17 • Aug. 21
Sept. 18 • Oct. 16
Nov. 20 • Dec. 18

*All located at the Children's
Services Council Auditorium
• MONTHLY VIDEOS •
http://www.youtube.com/user/
tcmug/videos
• BOARD OF DIRECTORS •
Friday - June 20 @ Chris'

A variety of programs for Beginners
to Advanced Mac enthusiasts.

MEETING INFO
(772) 283-5646
http://www.tcmug.net
Dues may be paid in person
(cash or check), by mail or
credit card (tcmug.net)

MAILING ADDRESS
Treasure Coast Macintosh
Users Group (TCMUG)
1819 SW Willowbend Lane
Palm City FL 34990

MEETING LOCATION
Children's Services Council • Stuart
http://tinyurl.com/clq2mkk
101 SE Central Parkway, Stuart • (772) 283-5646 • In the
Green building between Bridges Montessori and Unity Church.
West Palm Beach Apple Store - Gardens Mall:
http://www.apple.com/retail/thegardensmall/
West Palm Beach Apple Store - Wellington Green:
http://www.apple.com/retail/wellingtongreen/
Find Out How:
http://www.apple.com/findouthow/mac/
iPad User Guide for iOS 7 Software • 157 pages

http://manuals.info.apple.com/MANUALS/1000/MA1595/en_US/ipad_user_guide.pdf

iPhone User Guide for iOS 7 Software • 157 pages

http://manuals.info.apple.com/MANUALS/1000/MA1565/en_US/iphone_user_guide.pdf

